Morningstar Advisor Workstation Training Guide

Overview to Morningstar Advisor Workstation™
## Contents

Summary:

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>4</td>
</tr>
<tr>
<td>Understanding the Home Page</td>
<td>5</td>
</tr>
<tr>
<td>Navigating in Advisor Workstation</td>
<td>6</td>
</tr>
<tr>
<td>Understanding the Research Module</td>
<td>8</td>
</tr>
<tr>
<td>Understanding the Clients &amp; Portfolios Module</td>
<td>9</td>
</tr>
<tr>
<td>Understanding the Hypotheticals Module</td>
<td>11</td>
</tr>
<tr>
<td>Understanding Investment Proposals</td>
<td>13</td>
</tr>
<tr>
<td>How to Begin Learning Morningstar Advisor Workstation</td>
<td>15</td>
</tr>
</tbody>
</table>
Overview to Morningstar Advisor Workstation℠

Morningstar Advisor Workstation℠ provides financial advisors with tools for investment planning, portfolio analysis, security research, and sales presentations.

This Quick Start Guide is designed to get you up and running quickly, taking you through the basics of researching investments, building sales illustrations, and generating some of our most popular reports.

Use this guide to familiarize yourself with Advisor Workstation and then take advantage of additional training resources provided on the last page of this guide. Morningstar offers a variety of training opportunities to make your experience with Advisor Workstation as productive as possible.

Note: Not all features and functions shown in this guide are available to all Morningstar Advisor Workstation users.
Understanding the Home Page

The Home Page of Morningstar Advisor Workstation provides a landing page for users upon logging into the application, as well as shortcuts to several different functions. This section details some of the most important features of the Home Page.

The Home Page consists of widgets offering direct access to many areas of Advisor Workstation. They can also tell you about your practice and the market. You can rearrange the position of each widget on the Home Page, and you can click the arrow in the upper-right corner of each widget to collapse (or expand) it.

The Quick Start widget gives you one-click access to some of the more frequently used functions in Advisor Workstation, such as creating client records or generating a security report.

The Recently Modified Files widget gives you convenient access to the last 25 saved files you accessed.

Use the Quick Start widget to create new files
Use the menu bar to collapse the widget or drag and drop to reposition the widget
Navigating in Advisor Workstation

This section explains how Advisor Workstation is organized as an application, and how you can find your way in it.

Advisor Workstation is organized by modules that contain unique functionality to assist with various aspects of your practice. You can access these modules using the left-hand navigation pane, or the tabs across the top of the window.

While working in a particular module, the drop-down field on the left side of the toolbar above the grid view gives you access to the other pages available in that module. The drop-down field to the far right of the toolbar gives you access to saved lists and searches pertinent to the area (Clients, Portfolios, Mutual Funds, Stocks, etc.) you are viewing.
Navigating in Advisor Workstation

How is Morningstar Advisor Workstation designed to be used?

The icons below the grid view allow you to manage the items displayed in the grid view. You can navigate to different pages, reset a universe after a search, select or deselect items, and view the number of results in the universe you are viewing.

Many pages in Advisor Workstation are depicted as a grid view, with rows of investments (or other items, such as portfolios or saved lists) and columns of data. Above the grid view is a toolbar with several icons. The menu options and icons vary from module to module.
Understanding the Research Module

The Research Module allow you to conduct research on a variety of investments, indexes, category averages, and more.

The Research Module can be used to quickly look up a piece of information (e.g., P/E Ratio, Annual Net Expense Ratio, 3 Yr % Rank in Category) about an investment. You can use the Research Module to find specific investments by name or ticker, or create a search to find securities matching criteria you specify. You can also generate security-level reports, analyze investments using graphs and create custom views in order to quickly access the data you want in grid views.

To access the Research Module, either click on the Research tab at the top of the screen, or use the left-hand navigation pane to select a universe.
Understanding the Clients & Portfolios Module

The Clients & Portfolios Module allows you to manage your clients and their holdings, and to perform analysis with portfolio-level reports.

The Clients & Portfolios Module allows you to see not only a list of all clients at once, but also all of their portfolios. You can combine clients into groups for householding. You can also create model portfolios, asset allocation models and custom benchmarks to use when making recommendations to your clients.

To create a portfolio, take the following basic steps:

1. At the top of the Advisor Workstation screen, click **File → New → Portfolio**. The Quick Portfolio window opens.
2. In the Investments tab, search for your investments.
3. Click the **Allocate** tab, and input the allocation.
4. Click **Save**. The Save dialog box appears.
5. Assign the portfolio as a **Model**, to a **Group**, or **Client**.
6. Type a **name** for the portfolio.
7. Click **OK** to close the Save dialog box.

   **Note:** You do not need to complete all tabs in the Quick Portfolio window, since default values are entered for you on the Annual Fees, Attributes and Report Options tabs. You can create your own pre-populated values by clicking the Update Preferences icon in the upper-right corner of the Quick Portfolio window.

8. Click the **Report Options** tab to select which reports to include in the output PDF.
9. From the toolbar, click the **Generate Report** icon to create the PDF.
Advisor Workstation allows you to select which reports you want to generate at the portfolio level. The options available include the following:

- **The Portfolio Comparison Report** shows a side-by-side comparison of two portfolios in terms of asset allocation, performance and volatility.
- **The Portfolio X-Ray Report** is the most straightforward way to communicate a portfolio’s overall investment strategy to your clients. It condenses vast amounts of investment information into a clear, concise summary that can be grasped at a glance.
- **The Portfolio Snapshot Report** contains three pages of in-depth portfolio analysis, such as portfolio composition, investment style, sector weightings, regional exposure, performance numbers, market maturity, stock type weightings, and MPT statistics.
- **The Stock Intersection Report** shows the 50 largest individual stock holdings in a portfolio, displaying overlap between the same holdings in multiple funds.
- **The Correlation Matrix** displays how similar portfolio holdings are to one another in terms of return patterns. Advisors can use this report to determine if a portfolio’s holdings are too similar in this manner, and thus would not offer protection against downside volatility.

These reports can be generated for a client’s portfolio or a model portfolio.
Understanding the Hypotheticals Module

Unlike the Portfolio Snapshot and Portfolio Comparison Reports, which show only three-, five- and 10-year returns, hypothetical illustrations can be customized to show the past performance of a group of securities over a time period you specify.

Hypothetical Illustrations help support a recommended investment or portfolio strategy to clients and prospects. It allows you to:

- Analyze past performance in relation to a benchmark or competing investments to accurately depict the investor experience
- Illustrate a portfolio with multiple investment types, a reinvestment or withdrawal strategy, and a customized rebalancing schedule, and
- Depict performance during a market downturn and highlight benefits of one investment strategy over another.

To create a hypothetical illustration, do the following:

1. From the Tools menu at the top of the Advisor Workstation window, select Hypothetical. The Hypothetical window opens.
2. On the Investments tab, use the Select Universe drop-down field to choose the type of security you want to find, then enter the names or ticker symbols for the investments.
3. Click Find. Matching securities will appear in the Total Search Results area.
4. To include a security in the Illustration, click once to select it, then click Add.
5. Repeat steps 2–4 until all securities for the portfolio appear in the Investments Selected for Illustration area.
6. Select the Buy/Sell tab to enter the Initial Investment, Time Period, Subsequent Investments or Withdrawals, Upward Adjustments, and any Transfers from one security to another you want to illustrate.
7. The Reinvest/Rebalance tab allows you to edit those two attributes.
8. The Fees tab allows you to enter standard, custom, or asset-based fees for the illustration.
9. The Taxes tab allows you to factor in taxes, where appropriate.
10. The Report Options tab allows you to choose the Report Type (either Portfolio, Individual Holdings, or Comparison) and to pick the reports you want to include in the illustration.

11. At the top of the window, click the Generate Report icon to create the hypothetical illustration.
Understanding Investment Proposals

Investment Proposals are a feature of the Planning Module in Advisor Workstation. The Investment Proposal tool helps you analyze a client’s current holdings and evaluate their suitability, taking into account the client’s risk tolerance.

Note: The Planning Module might not be available in your configuration of Advisor Workstation.

Creating an investment proposal helps advisors tailor and present individualized investment strategies for each client. Proposals allow you to evaluate the asset allocation of a client’s current investments, determine an appropriate asset allocation based on the client’s risk tolerance level, and present a recommended portfolio.

Wealth Forecasting proposals allow you to include a client’s retirement needs and sources of income in order to determine whether they are saving enough to meet their long-term goals.

The Wealth Report evaluates a client’s chance of meeting their retirement goals.
To create an investment proposal, do the following:

1. From the **Tools** menu at the top of the Advisor Workstation window, select **Investment Proposal**. The Client/Group dialog box opens.
   - Note: If you do not see this option, it means you do not have access to the Planning Module.

2. In the Client/Group selection dialog box, search for the **client** or **group** you want to create a proposal for.

3. Click **OK**. The Proposal window opens.

4. Complete the data fields in each section, using the **Next** buttons in the bottom-right corner to move through the tool.

5. A variety of Proposal Types are available. Proposals can be created using client portfolios or a specific dollar amount.

6. In the Risk and Suitability section, the Risk Questionnaire identifies the client’s Risk Profile and is used to determine an asset allocation in the next section.

7. The Asset Allocation section allows you to view the Asset Allocation Model.

8. Next is the Portfolio Construction section, which allows you to create a proposed portfolio by using a saved model, incorporating securities from the current portfolio, or creating one from scratch.

9. In the Reports section, select the reports to include in the output PDF.
How to Begin Learning Morningstar Advisor Workstation

Now that you have read a bit about each part of Advisor Workstation, you can begin practicing with it. Learning Advisor Workstation consists of the following two elements:

1. Learn about and practice creating lists, searches, and custom views. You will need these skills in different modules throughout the application.

   Note: It is recommended you complete these training guides in the order listed, and complete all exercises in each one, as the exercises build on one another, and the work you complete in one guide could be referenced in another.

2. Use a workbook guide covering a set of workflows to learn how different parts of Advisor Workstation work together.